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Cisco CallManager AutoAttendant

Cisco CallManager AutoAttendant は、発信者が電話受付係と話をせずに組織内の人物を検索できる、

シンプルな自動アテンダントです。発信者に対して再生されるプロンプトはカスタマイズできます

が、このソフトウェアが発信者と対話する方法はカスタマイズできません。

Cisco CallManager AutoAttendant は、Cisco CallManager 5 agent IPCC Express Bundle にある 

Cisco CallManager とセットで販売されています。

この章では、Cisco CRS 4.5 上で動作する Cisco CallManager AutoAttendant について説明します。

（注） Cisco CallManager でサポートされる Cisco CRS のバージョンについては、次の URL で 
Cisco CallManager Compatibility Matrix を参照してください。
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_callmg/ccmcomp.htm#CompatibleApplications

Cisco CallManager AutoAttendant を理解、インストール、設定、および管理するには、次のトピック

を参照してください。

• Cisco CallManager AutoAttendant（P.7-2）

• Customer Response Solutions（CRS）Engine のインストールとアップグレード（P.7-4）

• Cisco CallManager AutoAttendant と CRS Engine の設定（P.7-6）

• Cisco CallManager AutoAttendant の管理（P.7-24）
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Cisco CallManager AutoAttendant 
Cisco CallManager AutoAttendant は、Cisco CallManager と連携して、特定の電話内線宛のコールを受

信します（図 7-1 を参照）。発信者と対話して、発信者が組織内の通話相手の内線番号を検索し、選

択できるようにします。

次の項では、Cisco CallManager AutoAttendant について説明します。

• Cisco CallManager AutoAttendant の概要（P.7-2）

• Cisco CallManager AutoAttendant のコンポーネント（P.7-3）

図 7-1 Cisco CallManager AutoAttendant の使用方法

Cisco CallManager AutoAttendant の概要

Cisco CallManager AutoAttendant は、次のスクリプトを提供します。

• コールに応答する。

• ユーザが設定可能なウェルカム プロンプトを再生する。

• 発信者に対して、次の 3 つのアクションのいずれかを実行するように求めるメイン メニュー プ
ロンプトを再生する。

－ 0 を押してオペレータを呼び出す。

－ 1 を押して内線番号を入力する。

－ 2 を押して名前を入力する。

• 発信者が名前入力を選択した（2 を押した）場合は、発信者の入力した文字と、利用可能な内

線番号に対して設定されている名前を比較する。

－ 一致する名前が存在する場合は、一致したユーザに転送することを通知する。発信者は、

転送を停止するには 2 秒以内にいずれかの DTMF キーを押します。発信者が転送を停止し

ない場合、システムは明示的な確認処理を実行します。ユーザに対して、名前を確認する

ように求め、コールをユーザのプライマリ内線に転送します。
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－ 一致する名前が複数存在する場合は、発信者に対して、正しい内線を選択するように求め

る。 

－ 一致する名前が多数存在する場合は、発信者に対して、さらに文字を入力するように求め

る。

• 発信者が宛先を指定し終わったら、コールを転送する。

－ 回線がビジーになっている場合またはインサービスでない場合は、発信者に状況を通知し、

メイン メニュー プロンプトをもう一度再生する。

追加情報

P.7-25 の「関連項目」を参照してください。

Cisco CallManager AutoAttendant のコンポーネント

Cisco Customer Response Solutions Platform は、Cisco CallManager AutoAttendant の実行に必要なコン

ポーネントを提供します。このプラットフォームは、IP 対応のマルチメディア（音声 / データ /Web）

カスタマー ケア アプリケーション環境を提供します。

（注） Cisco Customer Response Solutions（CRS）は、Cisco CRS プラットフォーム上の製品である 
IPCC Express と IP IVR の名前で販売されています。 

Cisco CallManager AutoAttendant は、Cisco Customer Response Solutions Platform の 3 つの主要コン

ポーネントを利用しています。

• ゲートウェイ：エンタープライズ IP テレフォニー ネットワークを公衆電話交換網（PSTN）お

よびその他の構内電話システム（構内交換機（PBX）など）に接続する。ゲートウェイは、別

途購入する必要があります。

• Cisco CallManager サーバ：IP 電話の実装、ゲートウェイの管理、電話システムに対するフェー

ルオーバー サービスと冗長化サービスの提供、および Voice over IP トラフィックの

Cisco Customer Response Solutions（Cisco CRS）システムへの送信に必要な機能を提供する。

Cisco CallManager は、別途購入する必要があります。

• Cisco CRS Server：Cisco CallManager AutoAttendant を実行する Cisco CRS Engine を含む。

Cisco CRS Server と Cisco CRS Engine は、Cisco CallManager AutoAttendant のパッケージに含ま

れています。

Cisco Customer Response Solutions Platform の詳細については、次の URL を参照してください。

http://www.cisco.com/en/US/products/ps5883/index.html

追加情報

P.7-25 の「関連項目」を参照してください。
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Customer Response Solutions（CRS）Engine のインストールと
アップグレード

CRS をインストールまたはアップグレードするには、次の項を参照してください。

• ハードウェアとソフトウェアの要件（P.7-4）

• Cisco CallManager AutoAttendant のインストールまたはアップグレード（P.7-4）

ハードウェアとソフトウェアの要件

このバージョンの CRS をインストールするには、運用中の Voice over IP システムがすでに存在し

ている必要があります。Cisco CallManager 5.0 をインストールし、設定しておく必要があります。

CallManager は、テレフォニー システムを管理するソフトウェアです。

Cisco CallManager AutoAttendant は、Cisco Media Convergence Server（Cisco MCS）プラットフォーム

またはシスコ認定サーバ上で動作します。 

Cisco CallManager サーバがアプライアンス ベースのシステムを実行していることを確認してくだ

さい。

Cisco CallManager AutoAttendant のインストールまたはアップグレード

Cisco CallManager AutoAttendant を CRS サーバにインストールする前に、Cisco CallManager をアプ

ライアンス ベースのシステムにインストールしてください。詳細については、次のマニュアルを参

照してください。

• Cisco CallManager インストール マニュアル

http://www.cisco.com/univercd/cc/td/doc/product/voice/c_callmg/5_0/install/instcall/index.htm

• Cisco IP Telephony オペレーティング システム

http://www.cisco.com/univercd/cc/td/doc/product/voice/iptel_os/index.htm

Internet Explorer のプロキシ設定項目を設定し、内部および外部の Web サイトを参照できることを

確認します。プロキシ設定項目の設定の詳細については、ネットワーク管理者に問い合せてくださ

い。

始める前に

P.7-4 の「ハードウェアとソフトウェアの要件」で説明している、インストール前の要件をすべて

満たしていることを確認します。

次の項で、Cisco CallManager AutoAttendant のインストール方法について説明します。

• Cisco CallManager AutoAttendant のインストール（P.7-4）

Cisco CallManager AutoAttendant のインストール

次の手順では、初めて Cisco CallManager IPCC Express 5 Seat Bundle をインストールする方法につい

て説明します。この手順は、新規インストール後に 1 回だけ実行します。

手順 1

ステップ 1 CCO から MCS サーバに、Cisco CallManager AutoAttendant ソフトウェア パッケージをダウンロード

します。
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ステップ 2 .exe ファイルをクリックして、インストール プログラムを起動し、画面上の指示に従います。

追加情報

P.7-25 の「関連項目」を参照してください。
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Cisco CallManager AutoAttendant と CRS Engine の設定
ここでは、Cisco CallManager AutoAttendant の導入に備えて Cisco CallManager と Cisco Customer

Response Solutions（CRS）Engine を設定する方法について説明します。

Cisco CallManager AutoAttendant の設定チェックリスト

表 7-1 に、Cisco CallManager AutoAttendant を設定する手順を示します。

Cisco CallManager の設定

Cisco CallManager AutoAttendant を使用するには、Cisco CallManager を事前に設定しておく必要があ

ります。

これらのトピックは、Cisco CallManager の使用方法を理解していることを前提としています。

Cisco CallManager の詳細については、『Cisco CallManager アドミニストレーション ガイド』および

『Cisco CallManager システム ガイド』を参照してください。

Cisco CallManager AutoAttendant 用の Cisco CallManager ユーザの設定

AutoAttendant に CRS 管理者としてログインするユーザを作成します。 

手順

ステップ 1 Cisco CallManager で、User Management>End User を選択します。

ステップ 2 Find and List Users ウィンドウが開きます。Add New をクリックします。

End User Configuration ウィンドウが表示されます。表 7-2 の説明に従ってフィールドに入力します。

ステップ 3 ユーザを作成するには、Save をクリックします。

ユーザが追加されます。

表 7-1 Cisco CallManager AutoAttendant の設定チェックリスト

設定手順 関連手順と関連項目

ステップ 1 Cisco Customer Response Solutions（CRS）Engine を設定しま

す。Cisco CallManager AutoAttendant を使用するには、

Cisco CRS をインストールして設定しておく必要がありま

す。Cisco CRS Engine は、ソフトウェア、およびソフトウェ

アからテレフォニー システムへの接続を制御します。

P.7-9 の「Cisco Customer Response Solutions

Engine の設定」を参照してください。

『Cisco CRS Installation Guide』も参照してくだ

さい。

ステップ 2 Cisco CallManager AutoAttendant をカスタマイズして、

AutoAttendant のプロンプトを自動アテンダントの使用状

況に適したものにします。 

P.7-20 の「Cisco CallManager AutoAttendant の

カスタマイズ」を参照してください。
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表 7-2 Cisco CallManager AutoAttendant 用の Cisco CallManager ユーザの設定

フィールド 説明

LDAP Sync Status このフィールドには、System > LDAP > LDAP System メニュー オプ

ションで設定される LDAP 同期ステータスが表示されます。

User ID エンド ユーザの識別名を入力します。Cisco CallManager では、作成

後にユーザ ID を変更できません。使用できる特殊文字は、=、+、<、

>、#、;、\、""、およびブランクです。

Password エンド ユーザのパスワードとして 5 文字以上の英数字または特殊文

字を入力します。使用できる特殊文字は、=、+、<、>、#、;、\、""、

およびブランクです。

Confirm Password ユーザのパスワードをもう一度入力します。 

PIN Personal Identification Number（PIN）として 5 文字以上の数字を入力

します。

Confirm PIN PIN をもう一度入力します。 

Last Name エンド ユーザの姓を入力します。使用できる特殊文字は、=、+、<、

>、#、;、\、""、およびブランクです。

Middle Name エンド ユーザのミドル ネームを入力します。使用できる特殊文字は、

=、+、<、>、#、;、\、""、およびブランクです。

First Name エンド ユーザの名を入力します。使用できる特殊文字は、=、+、<、

>、#、;、\、""、およびブランクです。

Telephone Number エンド ユーザの電話番号を入力します。使用できる特殊文字は、（, ）

および - です。 

Mail ID これについては、Cisco CallManager Administration の Release 5.0（1）

で説明します。 

Manager User ID エンド ユーザ マネージャ ID を入力します。入力するマネージャ ユー

ザ ID は、エンド ユーザとしてディレクトリにすでに存在している必

要があります。 

Department エンド ユーザの部署情報（部署の番号や名前など）を入力します。

User Locale ドロップダウン リスト ボックスで、エンド ユーザに関連するロケー

ルを選択します。ユーザ ロケールは、言語やフォントなど、エンド

ユーザをサポートする一連の詳細情報を示します。 

Cisco CallManager は、エクステンション モビリティと Cisco IP Phone

User Options で、このロケールを使用します。CiscoCallManager エク

ステンション モビリティのログオンでは、ここで指定したロケール

が、デバイスおよびデバイス プロファイルの設定よりも優先されま

す。Cisco CallManager エクステンション モビリティのログオフでは、

Cisco CallManager は、デフォルト デバイス プロファイルで指定され

たエンド ユーザ ロケールを使用します。 

（注） エンド ユーザ ロケールを選択しない場合は、
Cisco CallManager サービス パラメータでデフォルト ユーザ
ロケールとして指定されたロケールが適用されます。 

Associated PC Cisco SoftPhone ユーザと Cisco CallManager Attendant Console ユーザに

対して、この必須フィールドを使用します。 



第 7 章      Cisco CallManager AutoAttendant
Cisco CallManager AutoAttendant と CRS Engine の設定

7-8
Cisco CallManager 機能およびサービス ガイド

OL-8141-01-J

Digest Credentials SIP 電話機に対してダイジェスト認証を設定した場合、Cisco

CallManager は、電話機が SIP 要求を Cisco CallManager に送信するた

びに電話機の ID を確認します。このフィールドに入力するダイジェ

スト資格情報は、Phone Configuration ウィンドウでダイジェスト ユー

ザを選択するときに、電話機に関連付けられます。 

英数字の文字列を入力します。 

（注） ダイジェスト認証の詳細については、『Cisco CallManager セ
キュリティ ガイド』を参照してください。 

Confirm Digest Credentials ダイジェスト資格情報を正しく入力したことを確認するため、この

フィールドに資格情報を入力します。 

デバイスの関連付け

Available Devices このリスト ボックスには、このエンド ユーザへの関連付けに利用で

きるデバイスが表示されます。 

このエンド ユーザとデバイスを関連付けるには、デバイスを選択し、

このリスト ボックスの下にある下矢印をクリックします。 

このエンド ユーザに関連付けるデバイスがこのペインに表示されて

いない場合は、次のいずれかのボタンをクリックして、その他のデバ

イスを検索します。 

• Find more Phones：このエンド ユーザに関連付けるために、さら

に多くの電話機を検索するには、このボタンをクリックします。

Find and List Phones ウィンドウが表示され、電話機を検索できま

す。

• Find more Route Points：このエンド ユーザに関連付けるために、

さらに多くのルート ポイントを検索するには、このボタンをク

リックします。Find and List CTI Route Points ウィンドウが表示さ

れ、CTI ルート ポイントを検索できます。

Controlled Devices デバイスを関連付けると、このフィールドにはエンド ユーザが制御

する説明情報（MAC アドレスなど）が表示されます。

エクステンション モビリティ

Available Profiles このリスト ボックスには、このエンド ユーザへの関連付けに利用で

きるエクステンション モビリティ プロファイルが表示されます。 

このエンド ユーザとエクステンション モビリティ プロファイルを関

連付けるには、プロファイルを選択し、このリスト ボックスの下に

ある下矢印をクリックします。 

Controlled Profiles このフィールドには、Cisco CallManager エクステンション モビリティ

のために設定されるエンド ユーザに関連付けられる制御デバイス プ

ロファイルのリストが表示されます。 

Default Profile ドロップダウン リスト ボックスで、このエンド ユーザのデフォルト

のエクステンション モビリティ プロファイルを選択します。 

Presence Group ドロップダウン リスト ボックスで、電話番号（プレゼンス エンティ

ティ）のステータスを監視するプレゼンス グループを選択します。 

表 7-2 Cisco CallManager AutoAttendant 用の Cisco CallManager ユーザの設定（続き）

フィールド 説明
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追加情報

P.7-25 の「関連項目」を参照してください。

Cisco Customer Response Solutions Engine の設定

Cisco CallManager および Cisco IP Telephony DirectoryConfigure と通信するよう、

Cisco Customer Response Solutions（CRS）Engine を設定します。次に示す設定手順を実行します。

• クラスタの設定（P.7-10）

• サーバの設定（P.7-11）

• JTAPI コール制御グループの追加（P.7-12）

• Cisco Media Termination サブシステムのプロビジョニング（P.7-14）

• 新しい Cisco CallManager AutoAttendant の追加（P.7-15）

• JTAPI Trigger の設定（P.7-17）

• Cisco CallManager AutoAttendant インスタンスの設定変更（P.7-20）

上のトピックで説明しているのは、Cisco CRS の使用と設定に関する基本事項だけです。詳細につ

いては、Cisco CRS のオンライン ヘルプを参照してください。

追加情報

P.7-25 の「関連項目」を参照してください。

SUBSCRIBE Calling Search 

Space
Cisco CallManager Administration で設定するすべてのコーリング サー

チ スペースは、SUBSCRIBE Calling Search Space ドロップダウン リス

ト ボックスに表示されます。 

SUBSCRIBE Calling Search Space により、Cisco CallManager がエンド

ユーザからのプレゼンス登録要求をルーティングする方法が決まり

ます。特にこの目的のためにコーリング サーチ スペースを設定する

には、すべてのコーリング サーチ スペースと同様に（Call Routing >

Class Control > Calling Search Space で）設定します。 

Allow Control of Device 

from CTI
このボックスは、デフォルトでオンになっています。CTI からデバイ

スを制御できるようにする場合は、このボックスをオンのままにしま

す。

電話番号の関連付け

Primary Extension このフィールドは、エンド ユーザのプライマリ電話番号を表します。

デバイスをエンド ユーザに関連付ける場合は、プライマリ回線を選

択しません。エンド ユーザは、電話機に複数の回線を持つことがあ

ります。 

ドロップダウン リスト ボックスで、このエンド ユーザのプライマリ

内線を選択します。

システムが Unity Integration 用に設定されている場合は、Create Voice

Mailbox リンクが表示されます。 

表 7-2 Cisco CallManager AutoAttendant 用の Cisco CallManager ユーザの設定（続き）

フィールド 説明
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ヒント Cisco CRS Administration を起動するには、Web ブラウザで http:// サーバ名 /AppAdmin を開きます。

「サーバ名」には、アプリケーション サーバの DNS 名または IP アドレスを指定します。このイン

ターフェイスを使用する方法については、Help をクリックしてください。

クラスタの設定

クラスタを設定するには、次の手順を実行します。

ステップ 1 UserID として Administrator、パスワードとして ciscocisco を使用して、CRS サーバにログインしま

す。 

ステップ 2 Cisco CRS Administrator Setup ウィンドウが表示されます。Setup をクリックします。 

ステップ 3 License Information ウィンドウが表示されます。Browse をクリックして、CCO からダウンロードし

た無料 IPCC Express ライセンスを検索します。ライセンスを強調表示して、Next をクリックしま

す。同じウィンドウが再び表示された場合は、Next をクリックします。 

ステップ 4 CallManager Configuration ウィンドウが表示されます。

• AXL Service Provider Configuration で、使用可能な AXL Service Providers が右側のフィールドに

表示されます。サービス プロバイダーを選択し、左向きの三角形のボタンをクリックします。

選択した AXL Service Provider が、Selected AXL Service Providers の下に表示されます。

User Name フィールドと Password フィールドに、Cisco CallManager 側で AXL を通じて情報に

アクセスするために使用するユーザ名とパスワードを入力します。

• Available CTI Managers の JTAPI Subsystem - JTAPI Provider Configuration で、適切な CTI Manager
を選択し、左向きの三角形のボタンをクリックします。選択した CTI Manager が、Selected CTI
Managers の下に表示されます。

User Prefix フィールドと Password フィールドで、ユーザ プレフィックスとパスワードを作成し

ます。

（注） CallManager Configuration ウィンドウの RmCm Subsystem セクションでは何も行いません。

• Next をクリックします。

ステップ 5 User Management ウィンドウが表示されます。Cisco CallManager ユーザが CMUsers フィールドに表

示されます。Cisco CallManager で作成したユーザを選択します。P.7-6 の「Cisco CallManager

AutoAttendant 用の Cisco CallManager ユーザの設定」を参照してください。

• 左向きの三角形のボタンをクリックします。選択したユーザは、CRS Administrator / Supervisor
フィールドに表示されます。

（注） Search をクリックすると、Cisco CallManager 側でユーザが検索されます。

• Next をクリックします。



第 7 章      Cisco CallManager AutoAttendant
Cisco CallManager AutoAttendant と CRS Engine の設定

7-11
Cisco CallManager 機能およびサービス ガイド

OL-8141-01-J

ステップ 6 Directory Setup ウィンドウが表示されます。ブラウザを閉じます。

これでクラスタの設定は完了です。

（注） クラスタの設定でユーザ名とパスワードを設定すると、サーバの設定でそのユーザ名とパスワード

が必要になります。 

サーバの設定

クラスタの設定後は、サーバを設定する必要があります。

ステップ 1 CRS サーバで、Start >Programs >Administrator Tools >Services の順にクリックします。

ステップ 2 表示されたウィンドウで Cisco CRS Node Manager を強調表示し、ウィンドウの上部にある Restart

Service ボタンをクリックします。

ステップ 3 CRS Administration を起動します。

ステップ 4 P.7-10 の「クラスタの設定」で User Management ウィンドウで選択したユーザ名を使用し、CRS サー

バにログインします。 

ステップ 5 Cisco CRS Administrator Setup ウィンドウが表示されます。Setup をクリックします。

ステップ 6 Component Activation ウィンドウが表示されます。CRS Agent Datastore、CRS Config Datastore、CRS

Engine、CRS Historical Datastore、CRS Node Manager、および CRS Repository Datastore の横にある

チェックボックスをオンにし、Next をクリックします。

ステップ 7 Publisher Activation ウィンドウが表示されます。各 Datastore に対して CRS を選択し、Activate

Publisher をクリックします。

ステップ 8 Server Setup ウィンドウが表示され、サーバの設定が完了したことが示されます。

（注） CRS Historical Reporting Client を使用している場合は、Server Setup ウィンドウの表示に従って HR
セッション ライセンスをアップデートします。

（注） これでサーバが設定されました。今後は、作成したユーザ名とパスワードを使用する必要がありま

す。

追加情報

P.7-25 の「関連項目」を参照してください。
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JTAPI コール制御グループの追加

JTAPI コール制御グループを追加するには、次の手順を実行します。

ステップ 1 Subsystems > JTAPI に移動します。JTAPI Call Control Configuration ウィンドウが表示されます。

ステップ 2 Add a New JTAPI Call Control Group をクリックします。表 7-3 に示す、必要な情報を入力します。

ステップ 3 Add をクリックします。

表 7-3 JTAPI コール制御グループの設定

フィールド 説明

グループ情報

Group ID このフィールドは、CRS サーバが Cisco ICM/IPCC Enterprise ソリュー

ションの一部となっている場合に Cisco ICM に報告された、トランク

グループ番号と対応しています。

自動 Group ID をそのまま使用するか、固有の説明を入力します。

Description Description フィールドに値を自動入力するには、Tab キーを押します。

Number of CTI Ports グループに割り当てる CTI ポートの数を入力します。

（注） このフィールドを <n> に設定した場合、各 CRS エンジン

ノード（CRS エンジン コンポーネントが有効なノード）に対

して <n> 個のポートが作成されます。

電話番号

Starting Directory Number このフィールドには、一意の電話番号を指定します。この値には、数

字と特殊文字 # および * を使用できます。

このフィールドで指定した値から始まる、指定した数のポートが作成

されます。

入力した電話番号は、複数のパーティションに表示されることがあり

ます。

（注） 電話番号としてパターンを使用した場合、ダイヤル先の電話

機の表示および発信者 ID 表示に、その番号が表示されます。

これを防ぐには、Display（Internal Call ID）、Line Text Label、
および External Phone Number Mask に値を指定します。
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Device Name Prefix このグループのすべての CTI ポートに与えられる名前に、デバイス名

プレフィックス（DNP）が使用されます。

このポート グループの CTI ポートには、次の形式のデバイス名が付

けられます。

<deviceprefix>_<directoryno>

たとえば、デバイス名プレフィックスが CTIP で、最初の電話番号が

7000 の場合、Cisco CallManager で作成される CTI ポートは、デバイ

ス名が CTIP_7000 になり、回線 7000 を使用します。

（注） デバイス名プレフィックスは 5 文字までです。

Device Pool この電話を割り当てるデバイス プール（リージョン、日付 / 時間グ

ループ、ソフトキー テンプレート、および MLPP 情報などのデバイ

スの共通特性のセット）を指定します。

DN Calling Search Space ダイヤルされた番号をルーティングする方法を決定するために検索

されるパーティションのコレクション、デバイスのコーリング サー

チ スペース、共に使用される電話番号のコーリング サーチ スペース

を指定します。電話番号 CSS は、デバイス CSS よりも優先されます。

Redirect Calling Search

Space
リダイレクトされたコールをルーティングする方法を決定するため

に検索する、パーティションのコレクションを指定します。

Media Resource Group List メディア リソース グループの優先順位付きグループ。アプリケー

ションは、Media Resource Group List で定義される専用の順序に従っ

て、利用可能なメディア リソースから Music On hold サーバなどの必

要なメディア リソースを選択します。

None を選択すると、Cisco CallManager はデバイス プールで定義され

たメディア リソース グループを使用します。

Location Cisco IP Phone のロケーション設定では、このロケーションへのコー

ルと、このロケーションからのコールで利用可能な帯域幅の合計を指

定します。ロケーション設定が None に設定されていると、ロケー

ション機能は、Cisco IP Phone で消費される帯域幅を追跡しません。

パーティション このフィールドは、電話番号が所属するパーティションを指定しま

す。電話番号のフィールド値は、選択するパーティション内で一意で

す。

電話番号へのアクセスを制限しない場合は、パーティション設定とし

て None を選択します。

電話番号の設定

Voice Mail Profile ドロップダウン リストから、None、NoVoiceMail または Default を選

択します。

表 7-3 JTAPI コール制御グループの設定（続き）

フィールド 説明

グループ情報
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Cisco Media Termination サブシステムのプロビジョニング

プロンプトと DTMF（Cisco Media Termination）をサポートするシンプルなタイプのメディアから、

プロンプトと DTMF に加えて音声認識をサポートする複雑で高度なメディアまで、さまざまなタイ

プのメディアを選択できます。メディアを使用せずにコールをプロビジョニングすることもできま

す。このような特徴があるため、メディアを手動でプロビジョニングする必要があります。後方互

換性を維持し、メディアの対話をサポートするために、コールごとにシステムに CTI ポートとメ

ディア チャネルが必要です。

さらに、メディア リソースは IVR ポートとしてライセンスが発行され、販売されているため、ラ

イセンスが発行されている数を超えてチャネルをプロビジョニングできます。ただし、実行時には

ライセンスが必要なため、システムはコールを受け入れません。これはライセンス許諾書に違反す

ることになります。

コール制御グループ、複数の CMT ダイアログ グループ、および Nuance ASR ダイアログ グループ

をプロビジョニングすることによって、複数のアプリケーション間でリソースを共有できるように

なります。さらに、特定のリソース セットを主に使用するように、特定のアプリケーションをプロ

ビジョニングすることもできます。これは、たとえば JTAPI Trigger を設定する場合に行うことがで

AAR Group ドロップダウン リストから、このデバイスの Automated Alternate

Routing（AAR; 自動代替ルーティング）グループを選択します。AAR

グループは、帯域幅不足のためにコールがブロックされないように、

コールをルーティングするためのプレフィックス番号を提供します。

AAR グループ設定を None にすると、ブロックされたコールの再ルー

ティングは試行されません。

User Hold Audio Source ドロップダウン リストから、ユーザが保留操作を開始したときに再

生されるオーディオ ソースを選択します。

Network Hold Audio Source ドロップダウン リストから、ユーザが保留操作を開始したときに再

生されるオーディオ ソースを選択します。

Call Pickup Group ドロップダウン リストから、指定されたパーティション内でこの電

話番号へのコールに応答するために、ダイヤル可能な番号を選択しま

す。

Display 最大 40 文字の英数字を入力します。通常は、ユーザ名または電話番

号を使用します（電話番号を使用する場合、着信側の電話機には発信

者の適切な ID が表示されないことがあります）。

内線番号を表示するには、このフィールドをブランクのままにしてく

ださい。

External Phone Number 

Mask
この回線からのコールの発信時に発信者 ID 情報の送信に使用される

電話番号（またはマスク）を指定するために、最大 30 桁の数字と「X」

文字を入力します。

X は電話番号を表し、パターンの末尾に付ける必要があります。 

次の例を参考にしてください。

マスクを 972813XXXX に指定する場合、内線番号 1234 からの外部

コールには、発信者 ID が 9728131234 と表示されます。

表 7-3 JTAPI コール制御グループの設定（続き）

フィールド 説明

グループ情報
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きます。詳細については、『Cisco Customer Response Solutions Administrator Guide』を参照してくだ

さい。

CMT ダイアログ グループのプロビジョニング

Cisco CRS Server は、メディア パケットを IP ネットワーク上で送受信するために、リアルタイム ト

ランスポート プロトコル（RTP）を使用します。CRS Engine が Cisco IP Telephony システムと通信

できるようにするには、CRS Engine が RTP データの送受信に使用する RTP ポートを設定する必要

があります。 

CMT ダイアログを設定するには、次の手順に従います。

手順

ステップ 1 Cisco CRS Administration に接続します。

ステップ 2 CRS Administration のメイン メニューで、Subsystems > Cisco Media を選択します。

Cisco Media Termination Dialog Group Configuration ウィンドウが表示されます。

ステップ 3 Add a New CMT Dialog Group ハイパーリンクをクリックします。

2 番目の Cisco Media Termination Dialog Group Configuration ウィンドウが表示されます。

ステップ 4 自動生成されるグループ ID をそのまま使用するか、Group ID フィールドにグループ ID を入力しま

す。

（注） このグループ ID は、すべてのメディア グループ識別子（ASR を含む）にわたって一意で

ある必要があります。

ステップ 5 Description フィールドに値を自動入力するには、Tab キーを押します。

ステップ 6 グループが利用できるチャネルの最大数を Maximum Number Of Channels フィールドに入力します。

ステップ 7 Add をクリックします。

Cisco Media Termination Dialog Group Configuration ウィンドウが表示されます。

新しい Cisco CallManager AutoAttendant の追加

JTAPI サブシステムを Cisco CRS Engine 上で設定したら、いずれかのサンプル スクリプトを使用し

てアプリケーションを作成し、Cisco CRS Engine を起動します。新しい Cisco CallManager 

AutoAttendant を追加するには、次の手順に従います。

ヒント Cisco CRS Administration を起動するには、Web ブラウザで http:// サーバ名 /AppAdmin を開きます。

「サーバ名」には、アプリケーション サーバの DNS 名または IP アドレスを指定します。このイン

ターフェイスを使用する方法については、Help をクリックしてください。
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手順

ステップ 1 CRS Administration のメイン メニューで、Applications > Application Management を選択します。

Application Configuration ウィンドウが開きます。

ステップ 2 Application Configuration ウィンドウの Add a New Application リンクをクリックします。

Add a New Application ウィンドウが表示されます。

ステップ 3 Next をクリックします。

Cisco Script Application ウィンドウが表示されます。

ステップ 4 アプリケーションの名前を Name フィールドに入力します。

ステップ 5 Description フィールドに値を自動入力するには、Tab キーを押します。

ステップ 6 一意の ID を ID フィールドに入力します。履歴レポートでは、この ID でアプリケーションを識別

します。

（注） ID はシステムによって自動生成されます。このため、フィールドに含まれている ID を使

用することも、値を削除して新しい ID を入力することもできます。

ステップ 7 Maximum Number of Sessions フィールドに、このアプリケーションを同時に実行できるセッション

最大数を入力します。

（注） Script と Default Script の選択内容に応じて、ウィンドウの表示が更新され、追加のフィール

ドとドロップダウン メニュー オプションが表示されます。

ステップ 8 Script ドロップダウンの矢印で、アプリケーションを実行するスクリプトを選択します。

Cisco CallManager AutoAttendant のスクリプトは aa.aef です。

ステップ 9 Default Script ドロップダウン メニューで、System Default をそのまま使用します。このデフォルト

スクリプトは、設定したアプリケーション スクリプトにエラーが発生したときに実行されます。

ステップ 10 Add をクリックします。

次のメッセージが表示されます。

「The operation has been executed successfully」

ステップ 11 ダイアログボックスを閉じるには、OK をクリックします。
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追加情報

P.7-25 の「関連項目」を参照してください。

JTAPI Trigger の設定

JTAPI Trigger を設定するには、次の手順を実行します。

ステップ 1 Subsystems > JTAPI を選択します。JTAPI Call Control Group Configuration ウィンドウが表示されま

す。

ステップ 2 左のカラムの JTAPI Triggers をクリックします。JTAPI Trigger Configuration ウィンドウが表示され

ます。

ステップ 3 Add a New JTAPI Trigger リンクをクリックします。2 番目の JTAPI Trigger Configuration ウィンド

ウが表示されます。

ステップ 4 表 7-4 に示す、必要な情報を入力します。

ステップ 5 Add をクリックします。

ステップ 6 Systems > Control Center を選択して CRS Engine - JTAPI をチェックし、動作していることを確認し

ます。動作していない場合はオプション ボタンをクリックし、Restart をクリックします。

表 7-4 JTAPI Trigger の設定

フィールド 説明

電話番号

Directory Number 一意の電話番号を入力します。この値は数字で構成され、特殊文

字（# または *）が先頭または末尾に付加されます。

有効な電話番号の例：

##*1100**
*#12#*

無効な電話番号の例：

*12*23#

Partition 電話番号が所属するディレクトリのパーティションを入力しま

す。電話番号のフィールド値は、選択するパーティション内で一

意にします。

電話番号へのアクセスを制限しない場合は、パーティション設定

として None を選択します。
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トリガー情報

Language ドロップダウン リストから、希望する言語を選択します。

希望する言語がドロップダウン ボックスに表示されない場合は、

Edit をクリックします。

• Employer User Prompt ダイアログボックスが開きます。ロケー

ル文字列値を入力します。

• OK をクリックします。そのロケール文字列値がドロップダ

ウン リストに表示されます。

• 希望する言語を選択します。

Application Name ドロップダウン リストから、トリガーに関連付けるアプリケー

ションを選択します。

Maximum Number of Sessions このトリガーが処理できる同時コールの最大数を入力します。

Idle Timeout (in ms) このトリガーに対する JTAPI 要求を拒否するまで、システムが待

機する時間（ミリ秒）を入力します。

Enabled トリガーを有効にするには、Yes を選択します。

トリガーを無効にするには、No を選択します。

Call Control Group ドロップダウン リストから、トリガーに関連付けるコール制御グ

ループを選択します。

Primary Dialog Group ドロップダウン リストから、トリガーに関連付けるダイアログ グ

ループを選択します（関連付けられるアプリケーションでメディ

アが必要な場合）。

Secondary Dialog Group このトリガー上の着信コールに対応できるだけの十分なリソース

がプライマリ ダイアログ グループにない場合、ドロップダウン

リストから、トリガーに関連付けるバックアップ ダイアログ グ

ループを選択します。

CTI ルート ポイント情報

Device Name このデバイスの一意の識別子を入力します。これは、英数字、ドッ

ト、ダッシュ、またはアンダースコアで構成されます。

Description CTI ルート ポイントのわかりやすい名前を入力します。

Device Pool ドロップダウン リストから、このルート ポイントを割り当てるデ

バイス プールを選択します。デバイス プールは、リージョン、日

付 / 時間グループ、ソフトキー テンプレート、および MLPP 情報

などのデバイスの共通特性のセットを定義します。

Location ドロップダウン リストから、このロケーションへのコールと、こ

のロケーションからのコールで利用可能な帯域幅の合計を選択し

ます。ロケーション設定が Hub_None に設定されていると、ロ

ケーション機能は、ルート ポイントが使用する帯域幅を追跡しま

せん。

表 7-4 JTAPI Trigger の設定（続き）

フィールド 説明

電話番号
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電話番号の設定

Voice Mail Profile Voice Mail Profile で設定されるボイスメール プロファイルのド

ロップダウン リストから、この電話番号を関連付けるプロファイ

ルを選択します。

デフォルトは None に設定されています。

Calling Search Space この電話番号から呼び出される番号を検索するパーティションの

ドロップダウン リストから、この電話番号を使用するすべてのデ

バイスに適用する値を選択します。

コール転送とコール ピックアップの設定

Forward Busy 次のオプションがあります。

• Voice Mail：Voice Mail Profile Configuration の設定を使用する

には、このチェックボックスをオンにします。

（注） このチェックボックスをオンにした場合、

Cisco CallManager は Destination ボックスおよび Calling 
Search Space の設定を無視します。

• Destination：コールを転送する宛先を入力します。

• Calling Search Space：ドロップダウン リストから、コールを

転送するコーリング サーチ スペースを選択します。

Call Pickup Group ドロップダウン リストから、（指定されたパーティション内で）こ

の電話番号へのコールに応答するために、ダイヤル可能な番号を

選択します。

Display 発信者の内線番号を表示するには、このフィールドをブランクの

ままにしてください。

または、最大 30 文字の英数字を入力します。通常は、ユーザ名ま

たは電話番号を使用します（電話番号を使用する場合、受信者は

発信者の適切な ID を確認できないことがあります）。

External Phone Number Mask この回線からコールが発信された場合に、発信者の ID 情報を送信

するために使用する電話番号（またはマスク）を入力します。

最大 30 の数字と「X」文字を入力できます。X は電話番号を表し、

パターンの末尾に付ける必要があります。

たとえば、マスクを 972813XXXX に指定する場合、内線番号 1234

からの外部コールには、発信者 ID が 9728131234 と表示されます。

表 7-4 JTAPI Trigger の設定（続き）

フィールド 説明

電話番号
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Cisco CallManager AutoAttendant のカスタマイズ

Cisco CallManager AutoAttendant には、録音済みのウェルカム プロンプトが添付されています。デ

フォルトでは、ユーザ名がアルファベット 1 文字ずつ読み上げられます。名前は発音されません。

独自のウェルカム プロンプトと音声ユーザ名録音を追加することで、自動アテンダントをカスタマ

イズできます。次の項では、Cisco CallManager AutoAttendant のカスタマイズ方法について説明しま

す。

• Cisco CallManager AutoAttendant インスタンスの設定変更（P.7-20）

• プロンプトの設定（P.7-21）

Cisco CallManager AutoAttendant インスタンスの設定変更

この項では、Cisco CallManager AutoAttendant の設定の変更について説明します。

ヒント Cisco CRS Administration を起動するには、Web ブラウザで http:// サーバ名 /AppAdmin を開きます。

「サーバ名」には、アプリケーション サーバの DNS 名または IP アドレスを指定します。このイン

ターフェイスを使用する方法については、Help をクリックしてください。

手順

ステップ 1 Cisco CRS Administration のメイン ウィンドウで、Applications > Configure Applications を選択しま

す。Application Configuration ウィンドウが表示されます。

ステップ 2 設定対象となる Cisco CallManager AutoAttendant インスタンスをクリックします。Cisco Script

Application ウィンドウが表示されます。

ステップ 3 変更可能な設定は、次のとおりです。

• Description：アプリケーションの説明。

• ID：アプリケーションの ID。システムは、このアプリケーションを識別するために、Historical
Reporting にこの ID を通知します。

• Maximum Number of Sessions：この自動アテンダントを同時に使用できる発信者の最大数。この

数は、自動アテンダント用に作成した CTI ポートの数を超えることはできません。

• Enabled：自動アテンダントが動作しているかどうかを識別する。

• Script：アプリケーションを実行するスクリプト。

• welcomePrompt：自動アテンダントが電話に応答したときに、最初に再生されるプロンプト。プ

ロンプトをアップロードする方法については、P.7-22 の「ウェルカム プロンプトの設定」を参

照してください。

• MaxRetry：エラーが発生した場合に、発信者が Cisco CallManager AutoAttendant スクリプトの

メイン メニューに戻される回数。デフォルトは 3 です。

• operExtn：オペレータが使用する電話の内線番号。

• Default Script：設定したアプリケーション スクリプトにエラーが発生したときに実行されるス

クリプト。

ステップ 4 Update をクリックします。
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追加情報

P.7-25 の「関連項目」を参照してください。

プロンプトの設定

Cisco CRS Administration の Media Configuration を使用して、Cisco CallManager AutoAttendant が使用

するプロンプトの内容を変更できます。組織内の各人物の音声名をアップロードすることもできま

す。音声名をアップロードすると、自動アテンダントが発信者に通話相手の確認を求めたとき、発

信者は、名前のアルファベットが 1 文字ずつ読み上げられるのではなく、音声で名前を聞くことが

できます。

次のトピックで、これらの機能のカスタマイズ方法について説明します。

• ウェルカム プロンプトの録音（P.7-21）

• ウェルカム プロンプトの設定（P.7-22）

• 音声名のアップロード（P.7-23）

ウェルカム プロンプトの録音

Cisco CallManager AutoAttendant には、録音済みの汎用ウェルカム プロンプトが添付されています。

自動アテンダントをカスタマイズして、組織での要件を満たす特定の役割を持つものにするには、

ウェルカム プロンプトを独自に録音する必要があります。

必要なファイル形式でプロンプトを保存できるソフトウェアであれば、任意のレコーディング ソフ

トウェアを使用してウェルカム プロンプトを録音できます。作成する Cisco CallManager

AutoAttendant インスタンスごとに、それぞれ異なるウェルカム プロンプトを録音できます。

ここでは、Microsoft サウンド レコーダーを使用してウェルカム プロンプトを録音する方法につい

て説明します。プロンプトは、CCITT（mu -law）8KHz、8 ビット、モノラル形式の .wav ファイル

として保存します。サウンド レコーダーを使用するには、システムにマイクロフォンとスピーカが

装備されている必要があります。

手順

ステップ 1 サウンド レコーダー ソフトウェアを起動します。たとえば、Start > Programs > Accessories >

Entertainment > Sound Recorder を選択します。

ステップ 2 Record ボタンをクリックし、グリーティングをマイクロフォンに向かって読み上げます。

ステップ 3 グリーティングをすべて読み上げたら、Stop ボタンをクリックします。

ステップ 4 グリーティングを次の手順で確認します。

a. Rewind ボタン（Seek to Start とも言います）をクリックするか、スライダを録音内容の先頭ま

でドラッグする。

b. Play ボタンをクリックして、録音内容を再生する。良好な録音を得られるまで、グリーティン

グの録音を繰り返します。

ステップ 5 良好なグリーティング録音を得ることができたら、録音内容を保存します。

a. File>Save As を選択します。
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b. レコーディング オプションを設定するには、Change をクリックします（この設定画面は、Sound
Recorder の File メニューから Properties を選択することでも表示できます）。次のオプションを

選択します。

• Name：[untitled] を選択します。

• Format：CCITT u-law を選択します。

• Attributes：8.000 kHz, 8 Bit, Mono 7 kb/sec を選択します。

Save As をクリックし、フォーマットの名前を入力してこれらの設定を保存しておくと、設定
を後で再使用できます。

c. Sound Selection ウィンドウを閉じるには、OK をクリックします。

d. ファイルの保存先ディレクトリを参照し、ファイル名を入力して、Save をクリックします。

ファイルの拡張子には、.wav を使用します。

追加情報

P.7-25 の「関連項目」を参照してください。

ウェルカム プロンプトの設定

Cisco CallManager AutoAttendant が使用できるウェルカム プロンプトは、Cisco CRS Engine に保存さ

れているものだけです。カスタマイズしたウェルカム プロンプトを使用するように自動アテンダン

トを設定するには、プロンプトをサーバにアップロードし、適切な Cisco CallManager AutoAttendant

インスタンスを設定します。

ヒント Cisco CRS Administration を起動するには、Web ブラウザで http:// サーバ名 /AppAdmin を開きます。

「サーバ名」には、アプリケーション サーバの DNS 名または IP アドレスを指定します。このイン

ターフェイスを使用する方法については、Help をクリックしてください。

手順

ステップ 1 Cisco CRS Administration のメイン メニューで、Applications > Prompt Management を選択します。

Prompt Management ウィンドウが表示されます。

ステップ 2 Language Directory ドロップダウン メニューで特定の言語、およびプロンプトのアップロード先と

なるディレクトリを選択します。

ステップ 3 次の手順に従って、新しいプロンプトを追加します。

a. Add a new prompt ハイパーリンクをクリックします。

Prompt File Name ダイアログボックスが表示されます。

b. Choose file ダイアログボックスを開くには、Browse をクリックします。

c. ソース .wav ファイルのあるフォルダに移動し、Cisco CRS Engine にアップロードする .wav ファ

イルをダブルクリックします。

d. Destination File Name フィールドをクリックして、選択した内容を確認します。

e. .wav ファイルをアップロードするには、Upload をクリックします。
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アップロードが正常に終了したことを示すメッセージが表示されます。

f. Return to Prompt Management ハイパーリンクをクリックします。

ウィンドウの内容が更新され、Prompt Management ウィンドウにファイルが表示されます。

ステップ 4 次の手順に従って、既存のプロンプトを新しい .wav ファイルに置き換えます。

a. 変更対象となるプロンプトの、Upload カラムにある矢印をクリックします。

Choose file ダイアログボックスが開きます。

b. 既存のプロンプトから置き換えて使用する .wav ファイルの名前を入力します。

c. .wav ファイルとプロンプト名の情報を入力したら、Upload をクリックします。

追加情報

P.7-25 の「関連項目」を参照してください。

音声名のアップロード

Cisco CallManager AutoAttendant は、発信者に対して、入力内容に一致する複数の名前から選択する

ように求めるときや、当該の通話相手に接続するかどうかを確認するように求めるとき、デフォル

トでは通話相手の名前のアルファベットを 1 文字ずつ読み上げます。音声名をシステムにアップ

ロードすると、1 文字ずつ読み上げる代わりに、音声で名前が再生されるようになります。

ユーザが発声した Cisco CallManager 音声名をアップロードするには、次の手順に従って各ユーザ

の .wav ファイルをディレクトリにアップロードします。

手順

ステップ 1 ユーザに対して、P.7-21 の「ウェルカム プロンプトの録音」で説明されている方法に従って名前を

録音し、ファイルを「ユーザ ID.wav」という名前で保存するように要請します。「ユーザ ID」は、

各ユーザのユーザ名です。

ステップ 2 Cisco CRS Administration に接続します。Tools > User Management を選択します。User Management

ウィンドウが表示されます。

ステップ 3 左側のメニューから Spoken Name Upload リンクをクリックします。

Spoken Name Prompt Upload ウィンドウが表示されます。User ID フィールドに、音声名をアップロー

ドするユーザの一意の識別子を入力します。

ステップ 4 Codec フィールドに、この CRS サーバのインストール中に選択されたコーデックが自動的に表示さ

れます。

ステップ 5 Spoken Name（.wav）フィールドで、アップロードする .wav ファイルを参照します。そのファイル

をクリックし、Open をクリックします。

ステップ 6 Spoken Name Prompt Upload ページで Upload をクリックします。

P.7-25 の「関連項目」を参照してください。



第 7 章      Cisco CallManager AutoAttendant
Cisco CallManager AutoAttendant の管理

7-24
Cisco CallManager 機能およびサービス ガイド

OL-8141-01-J

Cisco CallManager AutoAttendant の管理
Cisco CallManager AutoAttendant の管理には、Cisco CRS Administration を使用します。このインター

フェイスを利用して次の管理タスクを実行する方法については、オンライン ヘルプを参照してくだ

さい。表 7-5 に、管理タスクを示します。

追加情報

P.7-25 の「関連項目」を参照してください。

表 7-5 Cisco CallManager AutoAttendant の管理

タスク 目的
コマンド
（Cisco CRS Administration のメイン ウィンドウ内）

Cisco CRS Engine の起動

と停止

自動アテンダントを機能させる

には、このエンジンを実行する

必要があります。エンジンを停

止して再起動すると、問題の解

決やトラブルシューティングに

役立ちます。

System > Control Center を選択し、左側のメニューで

Cisco CRS Engine をクリックします。表示されるリストで、

「CRS Engine」を探します。Status カラムが右向きの三角形

のボタンになっている場合、そのエンジンは動作していま

す。 

このカラムに四角形が表示されている場合、エンジンは動

作していません。エンジンを再起動するには、「CRS Engine」

の横のオプション ボタンをクリックし、Restart をクリッ

クします。

動作しているエンジンを停止する場合は、「CRS Engine」の

横のオプション ボタンをクリックし、Stop をクリックしま

す。

Cisco CRS Engine の設定

の変更

問題を解決するために、エンジ

ンの設定を変更します。

System > System Parameters を選択します。

トレース ファイルの設定 トラブルシューティング情報を

収集するためのトレース ファ

イルを設定します。

System > Tracing を選択し、Trace File Configuration をク

リックします。詳細については、オンライン ヘルプを参照

してください。

トレース ファイルの表示 トレース ファイルを表示して、

トレース結果を参照します。

System > Control Center を選択し、「サーバ名」をクリック

します。Server Traces リンクをクリックします。作成した

トレース ファイルを選択してください。

リアルタイムのパフォー

マンス監視

リアルタイム レポート モニタ

をインストールする場合は、実

行されているシステムのパ

フォーマンスを監視できます。

Tools > Real-Time Reporting を選択します。Real Time

Reporting の使い方については、オンライン ヘルプを参照し

てください。
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関連項目
• Cisco CallManager AutoAttendant（P.7-2）

• Cisco CallManager AutoAttendant の概要（P.7-2）

• Customer Response Solutions（CRS）Engine のインストールとアップグレード（P.7-4）

• Cisco CallManager AutoAttendant のコンポーネント（P.7-3）

• ハードウェアとソフトウェアの要件（P.7-4）

• Cisco CallManager AutoAttendant のインストールまたはアップグレード（P.7-4）

• Cisco CallManager AutoAttendant のインストール（P.7-4）

• Cisco CallManager AutoAttendant と CRS Engine の設定（P.7-6）

• Cisco CallManager AutoAttendant 用の Cisco CallManager ユーザの設定（P.7-6）

• Cisco CallManager AutoAttendant の設定チェックリスト（P.7-6）

• Cisco CallManager の設定（P.7-6）

• Cisco Customer Response Solutions Engine の設定（P.7-9）

• クラスタの設定（P.7-10）

• サーバの設定（P.7-11）

• JTAPI コール制御グループの追加（P.7-12）

• Cisco Media Termination サブシステムのプロビジョニング（P.7-14）

• 新しい Cisco CallManager AutoAttendant の追加（P.7-15）

• JTAPI Trigger の設定（P.7-17）

• Cisco CallManager AutoAttendant のカスタマイズ（P.7-20）

• Cisco CallManager AutoAttendant インスタンスの設定変更（P.7-20）

• プロンプトの設定（P.7-21）

• ウェルカム プロンプトの設定（P.7-22）

• ウェルカム プロンプトの録音（P.7-21）

• 音声名のアップロード（P.7-23）

• Cisco CallManager AutoAttendant の管理（P.7-24）
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